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Welcome! Thank you for taking the time to read this information
pack. I aim to give you a breakdown of who I am, what I offer and
how I work. You will find it most helpful if you read this before our

first meeting. 

       

As a black woman, I am very aware of the need for more culturally
diverse therapists. For this reason, I am also a member of the Black,
African and Asian Therapy Network (BAATN). I am committed to
providing an anti-discriminatory service, particularly around issues
relating to the LGBTQIA+ community and people with disabilities.     

HI, I'M SAUNDRA 
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       You can read a bit about me here: https://therapyinprogress.com/about-
saundra-rhoden-expert-psychosexual-and-relationship-therapist-london-uk
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Face-To-Face therapy (otherwise known as in-person sessions) is suitable for people
who are looking for a private confidential space where they can meet away from the
distractions of the home environment. 
   
Sessions are held in a peaceful, comfortable room, only a short walk from London
Bridge and Borough Station in Central London.   As there is limited availability for in-
person sessions, slots cannot be guaranteed on a weekly basis.  

Current location: Langdale House, 11 Marshalsea Road, SE1 1EN.
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FACE-TO-FACE
THERAPY
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Online therapy works best when your privacy is managed safely and securely. Online
therapy is right for you if you have a private and confidential space where you will not
be interrupted. It allows you time and flexibility to have sessions from the comfort of
your own home, and it takes away the need to travel to appointments. For some
people, home does not feel like a safe place. If your conversation is likely to be
overheard or you share your computer with others, you may want to consider which
options would be best for you, so that you are managing your privacy during and
between sessions.  

Online therapy requires some adjustments to how we communicate. There are certain
body language cues that we may not notice as readily as we would in face-to-face
therapy. There may also be periods of silence during sessions. Silences can often be
used as a time to reflect and process feelings. However, it is helpful for us to agree on
how we manage this, so that there are no misunderstandings.   

I am currently using Zoom as my preferred platform. Zoom is an electronic application
that allows you to have video conference meetings over the internet. I may use another
application in the future. I will give you good notice of any potential change. There are
four different types of online therapy which I offer: video, audio, live chat, or email.   
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VIDEO

LIVE CHAT

AUDIO

It is like face-to-face; however, the visual view is
normally limited to the head and shoulders. The
camera and audio are switched on and kept on
throughout the session. You can use your laptop
for sessions. If you do not have a laptop and
need to use a tablet or mobile phone, you may
find the sessions tiring for your eyes. To improve
the sound quality, you can use headphones
during sessions.

This is where we communicate through the chat
feature on Zoom. We enter the session with the
camera and sound off and maintain this way of
communicating throughout the session. This
may be a preferred way to manage your privacy
if you live in shared accommodation or are likely
to be overheard. Or it may be your chosen way
to have sessions due to your personal
preference.  

This is similar to telephone sessions, but not the
same, as we meet on Zoom. You enter the
session with the camera off, but the sound is
kept on throughout the session. You can use
your mobile phone, tablet or laptop for
sessions.  
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Email therapy may be useful if live sessions are not
accessible for you during the day or evening. Or if you
like to take more time to reflect on your thoughts and
feelings.
 
This is where you set aside some time to write down
your thoughts and feeling on a Word document.
Allow yourself around 50 minutes to sit down and
write or you may want to write it in sections over a
longer period of time. The aim is to keep the word
limit to a maximum of about 1000 words.

EMAIL

ONLINE THERAPY
OPTIONS
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If there are any technical difficulties with using Zoom we can continue the session on
the Signal messaging service https://signal.org. The app is free and can be accessed on
Android, iPhone, and Desktop. 

If wifi/data coverage is lost during the session, within five minutes, please call my
mobile number: +447477 931 868.  

There are one of two options that we can agree to take. We will either continue the
session over the phone, or the session can be concluded with email therapy after
internet coverage is restored.  

7

BACKUP 
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What is Psychosexual Therapy? 

This is an approach to support individuals and couples who experience sexual-related
problems. Talking therapy is used to address difficulties for men, with erectile
dysfunction, delayed ejaculation, premature ejaculation, and lack of desire; women
who have pain during sexual intercourse, lack of arousal or interest, and other
difficulties with sexual performance. 

Part of the treatment may require you to have a medical check with your GP / Medical
Practitioner. I will usually also give you homework tasks between sessions to help you
towards improved sex and intimacy. 

This approach is best suited for face-to-face, video and audio sessions.
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TYPES OF THERAPY
OFFERED -

PSYCHOSEXUAL
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What is Couples Therapy?

Couples therapy is counselling offered to two people who define themselves as being in
a relationship. The couple can be gay, straight, bisexual, married, living together, in a
committed relationship, separated, or at the beginning of getting to know one another.
It involves meeting face-to-face or on video sessions. It is a space to work out
difficulties and improve understanding and communication.

In couples therapy, I see the couple as the client. It is not about favouring one person's
opinion over the other. The idea is to offer time to talk through difficult issues in the
presence of a therapist. I do not have an agenda of whether you should or should not
stay together.

You, as a couple, will decide what is best for you.
It is expected that you will both be ready to start the session together. It is best if both
partners are in the same room for video sessions, but I recognise that this may not
always be possible.
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TYPES OF THERAPY
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What is Eating Disorder Therapy? 

Disordered eating takes many forms and affects people in different ways: there may
not be a diagnosis. As opposed to a diagnosed eating disorder of Anorexia Nervosa,
Bulimia Nervosa, or Binge Eating Disorders. It can be physically and emotionally
difficult to overcome. 

The approach offered is based on training received from the NCFED. Coaching is given to
look at coping strategies and practical skills to support recovery. Homework tasks are
offered between sessions. 

It can be provided face-to-face, or through any online format. 
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DISORDERED 
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What is Gestalt Therapy?   

Gestalt is a German word. The closest translation is ‘whole’, ‘pattern’ or ‘form’. It is a
holistic process. This means that this approach sees the individual as a totality of mind,
body, emotions, and spirit who experiences reality in a way unique to themselves. It was
founded and developed by Fritz and Laura Pearls in the 1950s. 

Gestalt practitioners work with clients to help them focus on self-awareness: on what is
happening from one moment to the next. It supports you towards increased awareness
and understanding of thoughts, feelings, and behaviours: this can bring about powerful
change. This creative approach can be used with face-to-face sessions as well as audio,
video, live chat and email sessions. 
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TYPES OF THERAPY
OFFERED-GESTALT
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What is EMDR?  
 
Eye Movement Desensitisation Reprocessing (EMDR) uses a model called Adaptive
Information Processing. What this means is that it works with how we store memories
in our brains. EMDR was developed by Francine Shapiro in 1987, when she found it
successful in treating Post Traumatic Stress Disorder (PTSD). Since then, EMDR has been
used effectively to treat a wide range of conditions and problems such as stress, sleep
problems, anxiety, depression, self-esteem, and panic attacks. 
  
The mind can heal itself naturally, the same way the body can. Much of this natural
coping mechanism happens during sleep, particularly during rapid eye movement
(REM) sleep. We use eye movement stimulation as a method of treatment. During the
treatment, you will remain awake and alert. It is not a form of hypnosis, and you can
stop the process at any time during a session. It is a safe and effective treatment. 
 
The therapist needs to see and hear you during sessions, so it is best suited for either
face-to-face or video sessions on a laptop (not a phone, as the screen is too small for
eye movement simulation to work effectively). 
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TYPES OF THERAPY
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THE INITIAL
CONSULTATION 

I offer a free 15-minute consultation via the online platform, Zoom.   Please use this
link to book a timeslot: https://calendly.com/srhoden8/15min.  

If you have not used Zoom before, you will need to sign up for a free account at
https://zoom.us/. Once you are signed in, you should be able to click the link and join
the meeting without any difficulties. Please see the section entitled ‘Zoom Instructions’
for step-by-step guidance on how to do this. 

What happens during the consultation?

The initial consultation is an opportunity for you to ask any questions, and for me to get
a better understanding of whether I am the right therapist for you. If we agree to
proceed, we can then decide whether we will meet face-to-face or online (please see
the Online Therapy Options section for more details). 

What information do I need to give you?

If we agree to work together, I will email a link to complete the intake form before our
first session. The information you share will help me think and prepare fully for when
we meet. I will also be asking you to provide GP/Medical Practitioner and emergency
contact details. I will not contact your Medical Practitioner without your consent (please
see the Confidentiality Policy section for further explanation). 
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What to expect

Your first session will allow us to get to know each other a bit more time. I will use the
information that you shared in the intake form to guide the direction of the session.
What you share with me will aid a fuller assessment and understanding of your
history, needs and goals. I may also use other assessment tools to measure how you
are coping, so that I can address concerns and risks.   
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We will decide at the end of the session whether we both agree to meet on an ongoing
basis. If we decide to continue, I will then send you a client agreement form to sign and
return before we next meet. We will meet on a weekly or fortnightly basis depending
on your needs and availability. 

Our sessions can be on a short-term basis (which is usually between six-twelve
sessions) or a long-term basis.    

THE FIRST 
SESSION 
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REVIEW AND END 
OF THERAPY  

How  often do we review the progress of sessions?

I aim to offer a review to discuss how our sessions are going every six sessions.  

Who decides how and when sessions end?

Either you or I may decide to end the therapy. There is an expectation that some notice
of the ending would be discussed and mutually agreed upon. 

Where our work extends up to twelve sessions, I recommend a minimum of one ending
session. Where our work extends  longer, I suggest we arrange at least two sessions to
address any unresolved issues so that I can support you towards finishing safely with
enough resources.
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 Microsoft Word for Windows 365 
1.   Go to File > Info > Protect Document > Encrypt with Password  
2.   Type a password, then type it again to confirm it 
3.   Save the file to make sure the password takes effect 
4.   Attach the document to the email and send  

 Microsoft Word for MAC  
1.   Go to Tools > Protect Document  
2.   Type a password (to open the document), then type it again to confirm 
3.   Type a password (to modify the document), then type it again to confirm 
4.   Save the file to make sure the password takes effect  
5.   Attach the document to the email and send  

PDF documents  
1.   Go to File > Set Password  
2.   Type a password, then type again to verify  
3.   Save the file to make sure the password takes effect 
4.   Attach the document to the email and send  

After you have emailed the document, please text your password to +447477 931
868 
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FEES AND 
PAYMENTS

Fees are subject to periodic review. Any increase will be discussed and mutually agreed.

Sessions may be provided on a variable frequency (weekly or fortnightly) to match your
needs. 

Fees - Online / Face-To-Face:   

£90 for General Counselling / Psychosexual Counselling (50-minute session)  
£100 for Eating Disorder Therapy (50-minute session) 
£100 for EMDR Therapy (60-minute session)   
£130 for Couples Therapy (70-minute session)  
 
Payments:  

I will send an invoice in advance of the session, normally on the Monday of that week
(except on UK bank holidays, where this will be on Tuesday). I request that the invoice
be paid at least 48 hours before each session (please refer to the cancellation policy for
further details). 
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1.    Financial Responsibility: Your designated hour is reserved specifically for you, and
as such, you agree to pay for your appointment for the duration of our therapeutic
arrangement.

2. Cancellation and Reschedule Policy: 
 I ask that you give me as much advance notice as possible when cancelling a
session. Please provide at least 48 hours’ notice to avoid being charged for the
session 
You may cancel up to 4 times per year (for weekly sessions), and 2 times per year
(for fortnightly sessions) without paying the session fee when you cancel within the
48-hour notice period
You may reschedule appointments within the week before our next session,
provided our schedules align
You may request to schedule, reschedule or cancel an appointment by email or at
the end of a session
A no-show, late cancellation/late reschedule will result in a cancellation fee for
the full amount of the session

3.    Therapist Cancellations: You are not required to pay for sessions that I cancel. I will
make every effort to notify you in advance of any planned vacations or unexpected
circumstances that may affect our scheduled sessions.

Please send any requests to cancel or postpone sessions to:
Therapyinprogress@pm.me
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My privacy policy is outlined on my website: https://www.therapyinprogress.com.

Your privacy and confidentiality are less likely to be kept if you share your device
with other members of the household or use a computer in a public space 

To help maintain your privacy you must have a place where you will not be
disturbed. Where others cannot view your phone or laptop screen, and you cannot
be overheard. It is beneficial to use headphones during sessions  

I use the email provider Proton mail for correspondence. I strongly advise you to
sign up at https://protonmail.com to get the benefits of using a secure email
account  

You can delete any email exchanges between us or texts after you have accessed
them, to help maintain your privacy  

No visual or audio recordings of any kind will be taken of the sessions by either
party        

Any electronic data held on you is kept password-protected

Please see the therapy in progress cookies policy for information on how data is
managed on my website.  I conform to General Data Protection Regulations (GDPR),
and I am registered with the Information Commissioner’s Office (ICO) Registration
number ZA49449
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DATA PROTECTION
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Our sessions are confidential. The content of what is discussed during the session is
not shared. I will keep written notes of each session; these are kept electronically
on a password-protected computer that uses cloud-based storage. I will keep a
printed record of your contact details, in a separate locked cabinet, to use in an
emergency  

I attend regular supervision for guidance on my practice (please see the Code of
Ethics section for links to ethical frameworks which guide my practice). Any
information relating to your identity is not shared    

I share a list of client contact details with my clinical executors so that they can
contact you in the event of my death or inability to work (please see the Boundaries
of Contact section for further explanation about the clinical executors)

 
 I reserve the right to break confidentiality if there are immediate concerns about
your health and safety. I will take this action after I have informed you of this
decision. If there is high risk to yourself or others, I may need to share my concerns
with the appropriate authorities, such as emergency services, without your consent,
as a safeguarding measure

If there are concerns about the safety of a child or vulnerable adult in your care, I
may need to report these concerns to the appropriate authorities, such as Social
Services, as a duty of care  

There are specific conditions set out in which I have a legal duty to inform the
relevant authorities, such as the Police. These are in cases of suspected acts of
terrorism, drug trafficking or money laundering 
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You are welcome to follow my business page ‘Therapy In Progress’ on Facebook,
and Instagram 

Therapy in progress may publish content relating to mental health and well-being
on blog posts via Facebook, and Instagram 

Therapy in progress may sometimes share anonymised feedback from former
clients on the website. This is done to help potential clients understand how
therapy might be helpful  

To maintain professional boundaries, I will not request or accept personal friend
requests on any of my social media accounts, even after the therapeutic
relationship has ended 
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 COMPLAINTS
POLICY  

           
If you are unhappy with the standard of therapy that I provide, the first stage is to
arrange an appointment to discuss this further. You can also put your complaint in
writing via email at: Therapyinprogress@pm.me as an attached letter.  I aim to
respond within 7 days  

If you are not suitably satisfied with the outcome, you can complain to: COSRT (For
Psychosexual and Relationship Therapy).  You will find a copy of the COSRT
complaints document as well as timeframes via the link below:
https://www.cosrt.org.uk/wp-content/uploads/2022/02/COSRT-Conduct-
Procedure-2022.pdf

The UKCP (For all other therapies provided). You will find a copy of the UKCP
complaints document as well as timeframes via the link below:
https://www.psychotherapy.org.uk/ukcp-members/complaints/how-to-make-a-
complaint/

 
Both COSRT and UKCP recommends that complaints are sent to them within three
years of the incident, to ensure a more reliable account of events 
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As a UK-based therapist, any therapy that I offer is subject to the laws within
England and Wales. I have professional liability insurance with Oxygen (policy
number OXY9566099) to work with clients based in the UK and worldwide,
excluding the USA and Canada

I am not able to work with clients where I am not licenced to practice or where I am
at risk of breaking local laws by offering my services: this also includes individuals
and territories who are subject to international sanctions  

I am unable to offer emergency support, as I cannot guarantee my immediate
availability during working hours. If you are in crisis or need of urgent mental
health support, please contact emergency services relevant to your country or an
organisation such as https://www.befrienders.org  

My current working hours are Wednesday – Friday (12 pm-8:30pm) and Saturday
(9 am 4:30pm). I can only see you by appointment at our agreed time  

Sessions start and finish on time. I am unable to offer additional time if you arrive
late for sessions   

I cannot offer a session to you if you are:  
       under the influence of alcohol or drugs  
       driving a vehicle or operating machinery  
       nude/in a state of undress during video or face-to-face sessions  
       engaging in sexually explicit acts  

If we see each other in person unexpectedly, outside of the session, I will not
indicate the fact that you are or ever have been a client 

In the event of my sudden illness or death, I have a clinical will in place, with two
appointed clinical executors. The clinical executors are registered therapists, whom I
share emergency and client contact details with. This contact list is regularly
updated and shared on a password-protected document. Their role with be to
contact you to let you know and discuss onward arrangements 
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 I am registered to provide therapy under guidance from:  

The College Of Sexual Relationship Therapists (COSRT) Ethical Framework and Code
of Ethics https://www.cosrt.org.uk/professional-standards/code-of-ethics-and-
practice/

The UK Council for Psychotherapy (UKCP) Code of Ethics and Professional Practice
https://www.psychotherapy.org.uk/media/bkjdm33f/ukcp-code-of-ethics-and-
professional-practice-2019.pdf
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ALL THERAPEUTIC WORK IS UNDERTAKEN BY SAUNDRA RHODEN ON BEHALF OF
THERAPY IN PROGRESS LTD.

THERAPY IN PROGRESS LTD IS A PRIVATE COMPANY REGISTERED IN ENGLAND.
COMPANY REGISTRATION NUMBER: 08269804 REGISTERED ADDRESS: 128 CITY ROAD,
LONDON, EC1V 2NX

Any therapy in progress ltd contract and the work to which it relates are subject to the
jurisdiction of the laws of England and Wales.  

 
  
 
Thank you for taking the time to read this client information pack. I am happy to answer

any questions that you may have when we meet.  
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